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This is the user’s manual for the Installation and Commissioning manual*1.3

Document number: 1MRK 511 143-UEN

Revision: –

Issue date: February 2004

Data subject to change without notice

We reserve all rights to this document, even in the event that a patent is issued and a 
different commercial proprietary right is registered. Improper use, in particular repro-
duction and dissemination to third parties, is not permitted.

This document has been carefully checked. If the user nevertheless detects any 
errors, he is asked to notify us as soon as possible.

The data contained in this manual is intended solely for the product description and is 
not to be deemed to be a statement of guaranteed properties. In the interests of our 
customers, we constantly seek to ensure that our products are developed to the latest 
technological standards.

As a result, it is possible that there may be some differences between the HW/SW 
product and this information product.

IndustrialIT

Industrial IT enabled products from ABB are the building blocks for greater productiv-
ity, featuring all the tools necessary for lifecycle product support in consistent elec-
tronic form.
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ABB Automation Technologies AB
Substation Automation
SE-721 59 Västerås
Sweden

Telephone: +46 (0) 21 34 20 00
Fcsimile: +46 (0) 21 14 69 18
Internet: www.abb.com/substationautomation

© Copyright 2004 ABB. All rights reserved.
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Installation Manual
������������	������

This section describes how to install and commission CAP 540, PST, CAP 531 and 
SVT.
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#�	�����%������!������	��������	�
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�"��&������	���
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� ���������
	���	���	���	&�'�
����

This section describes how to install the CAP 540 Navigator.

� ������	���	���	���	������������	�)	��	���	�)* +�	
��'�	�!	,���	���

# )�����*"��"-	����������.�����	����
	/��
�0�	��.������

Enter your name in the first dialog. This name will appear under “Licensed to:”.
The following dialog appears:
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1  ��
	���	�����
�	��
	"��"-	&���	�!	,��	0���	��	"�������	0���	���	�������������

The License Agreement dialog appears.

� ���"-	&���	��
	���	)����������	2�"�����	
����
	�..����%
8
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� 3���"�	���	
��'�	��
	���	!��
��	0����	���	���	���	��!�0���	�����	��	��������
4	
��
	����	"��"-	&����

The Start Installation dialog appears:

5 ���"-	&���	��	"�������

The CAP 540 software Navigator is now being installed in your computer, showing 
you a installation progress bar. Then the following dialog appears:
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� ���"-	���	6�����	������4	��
	���	������������	��	"��.����
�

� &���	���.	��	��	�������	�����	��������	����	7��	�..��"�������

Follow the instructions on the screen until the installation is finished.
You may then have to restart the computer. 

# ���������
	�3�

This section describes how to install PST in the basic version of CAP 540 environ-
ment. The full version of CAP 540 includes configuration and is installed together 
with PST. When the installation starts, the following dialog appears:

(������)* ��
#
�����	

�

�  ��
	���	�����
�	��
	"��"-	+8	�!	,��	0���	��	"�������	0���	���	�������������

The following dialog appears:
10
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(�������* +�#��������������

#  ��
	���	2�"����	�
�������	��
	"��"-	�
���	��	"�������	���	�������������

The following dialog appears:

(������,* !�
�#��������	
�+�%�	�������	

�
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&���(
 ������-�#�
!��.����������������	��	�/
����	��%�����������������#���	����
���	%
��
��
�#��
��
������	�#��������	��
�$
�������������#��
�������������	

	��
���#��"�������
�#���������	%
�����
�#��
��
������"	���
�
�����-�#�
!��.��	""
�#	��
���������!������	�#�����	

�%��

#	���$

1 3���"�	���	"��"-	�����	!��	���	��������	���������	,��	0���	��	�������

� �!	,��	0���	��	"���
�	���	
����������	!��	���	���	�1�	������������4	"��"-	���	
����
�	������	��	���	��
��	�!	���	���	�1�	
����������	����

� �!	,��	0���	��	"���
�	���	
����������	!��	���	�3�	������������4	"��"-	���	
����
�	������	��	���	��
��	�!	���	�3�	
����������	����

5 ���"-	&����

The following dialog appears:

(�������* !������ ��
��	��
����	

�

� ���"-	���	��!��������	��
	"�����	���	�!	���	!����0��
	�0�	���.�%

� �����������	�
������
	�������������	���

� �����	�����������	��	����������������	���

The PST software is now installed in your computer, showing you a installation 
progress bar.
12
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� /���	���	������������	��	"��.����4	"��"-	+8	��	�������	,���	"��.�����

After restarting your computer, you can begin using the tools and the terminal 
libraries in the PST software package.

The installation sets up the following program entries in the start menu under Pro-
grams\PST.

(�������* �!����	�������

�
&���(
������
"����#��
������	�	������!��������


������� ��������01"

��������	

��$� ���
��
�
��
���	&�����
���
���#
�"������������
"����#��
����

�%����	&	�
	%
�$

�����!��#	��
��%����	�������
������"�
��	����	�������$� �����	
�	�����	�������
������
�	&��	��
����&��
��������� ���$

1 ���������
	���	�1�	9+.����:

When CAP 531 is included in the product it is part of the PST installation.
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� ���������
	3;�	9+.����:

The installation starts, when you run “SVTSetup.exe”. The following dialog appears.

�  ��
	���	�����
�	��
	"��"-	+-	�!	,��	0���	��	"�������	0���	���	�������������

The following dialog appears:

#  ��
	���	2�"����	�
�������	��
	"��"-	�
���	��	"�������	���	�������������
14
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The following dialog appears:

1 �!	,��	0���	��	"���
�	���	
����������	!��	���	3;�	������������4	"��"-	���	
����
�	������	��	���	��
��	�!	���	3;�	
����������	����

� ���"-	&����

The following dialog appears:
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� ���"-	���	��!��������	��
	"�����	���	�!	���	!����0��
	�0�	���.�%

� �����������	�
������
	�������������	���

� �����	�����������	��	����������������	���

The SVT software is now installed in your computer, showing you an installation 
progress bar.

The following dialog appears:

5 /���	���	������������	��	"��.����4	"��"-	6�����	��	����	���	�������������

Settings Visualisation Tool, SVT, can be started from Parameter Setting Tool, PST, 
from Edit menu or by clicking the SVT icon in the toolbox.

�
&���(
������
"����#��
�����!2�������� ��������01"

��������	

��$� ���
���
��
���	&�����
��
�
���#
�"������������
"����#��
����

�%����	&	�
	%
�$
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� ���������
	���	 �����	�����"����	9+.����:

This section describes how to install the Remote Connection option.

� ������	���	���	���	������������	�)	��	���	�)* +�	
��'�	�!	,���	���

# )�����*"��"-	 �����3���.����	����
	/��
�0�	��.������

1 ���"-	+8	������	��	�����	�������������
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Commissioning
������������


This section outlines a quick-guide on how to set up and commission the system as 
shown in the CAP 540 example system architecture. More information can be found in 
the CAP 540 manual. The option for remote connection enables remote connection, 
disturbance file transfer to FTP Server and Email notification when new disturbance 
files are available.

5 3,����	����.

The figure below shows the example system used in this quick guide.

5�� ���	���	�,����	�'��'��0

(������3* ���������1	�"
���������	�#����#����
18
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5�# <�0	��	����.	���	�,����	�=��.����

5�#��  �����	�����"����	��	3������	��	9��
��:

For the remote connection to a Station PC you need a Central PC, a Station PC, two 
modems and a terminal. Connect the rear SPA port of the terminal via a fiber opto/
electrical converter to the serial port 2 (COM2) and the station modem to the serial 
port 1 (COM1) of the Station PC. It is necessary to change the switches in the con-
verter when connecting it to a PC. It is also possible to keep the settings and instead 
use a null modem. Connect the local modem to COM1 of the Central PC. Remember 
to connect the prepared station modem to the Station PC, for more details see Commu-
nication Settings/Modem Info in the CAP 540 manual.

Create two identical projects, one in Central PC and one in Station PC. The import/
export function secure that the two projects are identical.

In the Station PC the SPA Server must be started by clicking on SPA Server in menu 
Tools. In the SPA Server Settings dialog select Modem port 1 (COM1) and SPA port 2 
(COM2) and check the Start SPA Server check box. The SPA TimeOut is normally not 
necessary to change.

����	�����>6��

A printer/fax driver must be installed in Central PC and/or Station PC in case Auto 
Print is to be used.

� +�	���	���
���	����4	"��"-	)��������"�	�'���������	

• In REVAL: 

- On the File menu, click Automatic Print Setup.

# 3���"�	���	
�!����	/��
�0�	.������	��	�������	�	!��	����	.������
�	3���"�	���	
6��	
��'��	��	�������	#�

1 ���"-	+8�

See the Fax driver manual for correct set up with phone numbers etc.

5�#�#  �����	�����"����	��	3��'��	��	9&��0��-:

For the remote network connection to a Server PC you need a Client PC, a Server PC 
and a terminal.

������	��	����.

In menu Settings/Communication Settings check the Network Connection check box. 
Three conditions must be fulfilled to be able to check it: The project which must be 
opened in both Client PC and Server PC must be located on a shared network disk, the 
PC type in menu General Settings must be Client and the Remote Connection option 
must be installed. For all other cases the check box will be disabled.
191MRK 511 143-UEN*1p3r-
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The Server Name or the IP address to the TCP Server PC must be typed in the Server 
Name text box in Communication Settings. The Port Number 80 should normally not 
be changed. The same port number as in TCP Server of the Server PC must be used. 
The Communication Parameters and the Connection type Direct set in the Server PC 
������
��%��#�	����$

3��'��	��	����.

In Communication Settings select Serial Port COM2 and Connection Direct. The Net-
work check box, Server Name text box and Port Number list box should all be dis-
abled.

In the Server PC the TCP Server must be started by clicking on TCP Server in menu 
Tools/Network. The TCP Server dialog could then be hidden by clicking on Hide in 
menu View.

���������	3�����
	����.

Run Parameter Setting Network Setup from Start/Programs/PST/PST Network Setup.

Select Peer-to-Peer Model unless you have a Windows NT Server, Windows 2000 
Server or 2003 Server. This application shall be executed on both the Server PC and 
the Client PC.

��..��
	�!	��	�

������

The Server PC must be aware of the Client PC’s IP-address and PC name as well as the 
Client PC must be aware of the Server PC’s IP-address and PC name.

This shall be done in the file named “hosts” (located in \\winnt\system32\drivers\etc or 
\\windows\system32\drivers\etc depending on your operating system.

Open the hosts file with Notepad and add a line last in the file according to the table 
below. Note that the PC's must be restarted to make the changes in the hosts file to take 
effect. 
20
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If you have several Client PC’s, just add the entries for all the Client PC’s in the Server 
PC hosts file.

&��0��-	��..����
	!��"�����

The functions below are network supported:

When these functions are started from Client PC the network connection will be estab-
lished automatically if the setup above is done. A check of user authority is done 
��
!��&����� before the network function is performed. If the user name or/and password 
are not valid an error message from the Server PC will appear.

5�#�1  �����	�����"����	��	6��	3��'��	9&��0��-:

In order to enable automatic file transfer to a FTP Server, either the Central PC and/or 
Station PC must be connected to the network. In this quick guide the Remote PC is 
connected to the network.

A FTP Server must be installed and configured in the FTP Server PC with user read 
and write permissions to CAP 540 directory and User Defined Directory (see Commu-
nication Settings in the CAP 540 manual for more details).

The CAP 540 project should also reside on the FTP Server PC. The project shall con-
tain a structure of Organization, one Station, one Bay and the respective Terminals.

������	��	�����	!���	 3��'��	��	�����	!���

PC name: Client PC1

IP address: 10.0.0.1

PC name: Server PC1

IP address: 10.0.0.2

Hosts file entry:

10.0.0.2 Server PC1

Hosts file entry:

10.0.0.1 Client PC1

Station Disturbance Upload

Terminal Disturbance List

Manual Disturbance Upload

Manual Trig

Clear LED’s

Clear all Recordings

Parameter Setting

Terminal Emulator

HMI LED Indications

Terminate Processes
211MRK 511 143-UEN*1p3r-
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5�1 )��������"�	6���	�����!��	93������	��	→	�������	��	→	6��	3��'��	
��:

5�1�� ���.��������	��	3������	��

Communication settings: 

� 3����	���	���	��	3������	���	

#  �
��*"��"-	��	���	3������	��
�	��	���	���	&�'�
�����	

1 3���"�	�������"�����	3�����
��	

� 3���"�	3�����	����	�+�#4	"���
�	���!�
�������	��	3������	��	?	��������	
9)���"�:�

�  �
��*"��"-	��	@�������

5 3���"�	3�����
��

Set PC Type to Server, Modem Port to 1, SPA port to 2 and SPA Time-Out to 5. 

In the Communication Settings dialog uncheck the boxes “Send Disturbance Files to 
Server” and “Send HTML Files to Server”. Select the radio button Auto Print/No Print 
and Disturbance File Format/REVAL.

� 3���"�	��
	���	���	������
�	!��	,���	��
��

5�1�# ������	���


If there are no disturbance files in the terminal it is possible to create a new Distur-
bance in the terminals by using Manual Trig for testing purposes.

�  �
��*"��"-	��	�	��������	��
��

# 3���"�	)��������"�	<��
���
�

1 3���"�	������	���
	

5�1�1 ���.��������	��	�������	��

Communication settings:

� 3����	���	���	��	�������	���

# 6��	��"�	�������	��
�A	 �
��*"��"-	��	�	�������	��
�	��	���	���	&�'�
�����	

1 3���"�	�������"�����	3�����
��

� 3���"�	3�����	����	�+��4	"���
�	���!�
�������	��	�������	��	?	3������	��	
9��
��:	

� 3���"�	��
	���	���	������
�	!��	,���	��
��

5 �,.�	���	.����	������	��	���	������	�������	��
���

&���(
�������
�����#	��
����������4-
���� ��
�������������
��	��
��	%
�����������
����$�
�������������1	�"
����	���
���
�5��
��	

�"�
�������
�5�
"��	�
��$
22
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�  �
��*"��"-	��	@�������

� 3���"�	3�����
�	��
	����"�	��	�,.�	��	�������	

Dial the station. 

B  �
��*"��"-	��	���	�������	��
�	��
	����"�	)����	

�� ���"-	"����"����	������	��	���	������	���	��	���	����

�� /���	����	��	"����"��
4	��
��*"��"-	��	�	3������	��
�	��	���	���	&�'�
����	

�# 3���"�	3������	)��������"�	6���	�����!���	

Wait until the communication process is finished. Check that all disturbances in the 
Station PC has been uploaded to the Central PC by selecting the terminal nodes and 
viewing Disturbance Records List. The new uploaded disturbances shall be visible 
in blue color. 

)��������"�	!���	�����!��	��	6��	���'��

In the Communication Settings dialog type:

• Server Name

• User Name

• Password in FTP Server Data text boxes. 

� 3���"�	���	��
��	������	C)�!����	3��'��	6���	����	9��������	����:D	��	�����
�	
��"�����	!��	���	)��������"�	!����	��	6��	3��'���	

With this setting the disturbance files will be stored in the CAP 540 structure on the 
FTP Server

# ���"-	���	���	C3��
	)��������"�	6����	��	3��'��D	

1 E�"��"-	���	���	C3��
	<��2	6����	��	3��'��D�

� 3���"�	���	��
��	������	����	�����>)��������"�	��
	<��
��	��
	)��������"�	
6���	6�����>�+�� �)��
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The �
	����������� button, on the right side of the Communication Settings dialog 
box (level with Auto Polling) opens up a dialog box.

A summary of a disturbance data is sent via Email to specified Email addresses. 
Email settings dialog box

Mail Server Type the server name to mail to.

Subject Type a subject which characterizes the disturbance.

Email to Type in the receiver´s Email address.

Email from Type in your own Email address

Send Disturbance Sum-
mary

Send disturbance summary from latest polling as attach-
ment, see example below.
24
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Example of Send Disturbance Summary

5�1�� ����	�"��
����	!��	��������"	)��������"�	6���	�����!��	��
	.������


Start Time Scheduler in Station PC:

�  �
��*"��"-	��	�	3������	��
�

# 3���"�	�������"�����	3�����
��

1 3���"�	���	)��������"�	��
	<��
��	��
��	������	��	���	����	������
	��
	����	
�����	!�����

� ���"-	+8�

� 3���"�	���
�����

5 3���"�	)��������"�	�'��������	!��	����	.������
�

• In REVAL:

- On the File menu, click Automatic Print Setup.

� 3���"�	���	
�!����	/��
�0�	.������	��	�������	��	3���"�	,���	!��	
��'��	��	
�������	#�
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Start Time Scheduler: 
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In Time Scheduler:

Send Disturbance Files Send disturbance files from latest polling as attachments.

Send Log Files Send log files from latest polling as attachments.

Email Filter When this box is checked Email will only be sent if the 
Trig Signal is one of the checked signals in the Terminal 
Digital Channels List.

Station: Stn 1

Bay: Bay 1

Terminal: REL511 V2.0 Line Protection

Terminal type: REx500 2A

Disturbance Date: 03-11-04

Disturbance Time: 04:55:10.245

Disturbance File: 03110407.REH

Trig: ZM3-TRIP

Recording Number: 7

Fault type: L1-N

Fault Location: 37.8%
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Commissioning
Set Periodicity Hour and Minute to one for starting Disturbance Upload. 
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Set Periodicity Hour and Minute for starting Disturbance File Transfer. 

1 ���"-	��	3����	�������	

The Central Auto Polling should now be started in accordance with the selected 
time period.
26
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SOFTWARE LICENSE

• This ABB Automation Technologies AB License Agreement (”License”) grants you the nonexclusive right to use 
one copy of the enclosed software program (”SOFTWARE”) on a single computer (i.e., with a single CPU) at 
a single location at any time. If you have multiple Licenses for the SOFTWARE you may have as many copies
of the SOFTWARE in use as you have Licenses.

• The software is owned by ABB AB or its suppliers and is protected by Swedish 
copyright laws, international treaty provisions, and all other applicable national laws. Therefore you must treat 
theSOFTWARE as any other copyrighted material (e.g., a book or musical recording) except that if the 
software is not copy protected you may either (a) make a copy of the SOFTWARE solely for backup or archival
purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for
backup or archival purposes. You may not copy the Documentation accompanying the SOFTWARE.

• The License is effective until terminated. This License will terminate automatically without notice from
ABB AB if you fail to comply with any provision of this License. Upon termination you
shall return the diskettes containing the SOFTWARE and all Documentation to ABB AB 
and destroy any copies of the SOFTWARE or any portions of it which has not been returned to ABB 

AB, including copies resident in computer memory.

• You may not rent, lease, lend, sell or give away the SOFTWARE, but you may transfer your rights under
this ABB AB License Agreement on a permanent basis provided you transfer all copies 
of the SOF TWARE and all written materials, and the recipient agrees to the terms of this Agreement. You
may not modify, adapt, translate, reverse engineer, decompile, disassemble, or create derivative works based
on the SOFTWARE. You may not modify, adapt, translate or create derivative works based on the written
materials.

LIMITED WARRANTY

• ABB AB’s entire liability and your exclusive remedy shall be, at ABB 
AB’s option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that 

does not meet ABB AB’s Limited Warranty and which is returned to ABB 
AB with a copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has 

resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the 
remainder of the original warranty period or 30 days, whichever is longer.

• ABB AB disclaims all other warranties, either express or implied, including but not 
limited to implied warranties of merchantability and fitness for a particular purpose, with respect to the 
WARE, accompanying Product Manual(s) and written materials. This warranty gives you specific legal rights.

• Neither ABB AB nor anyone else who has been involved in the creation, production or
delivery of this product shall be liable for any direct, indirect, consequential or incidental damages (including
damages for loss of business profits, business interruption, loss of business information, and the like) arising
out of the use or inability to use such product even if ABB AB has been advised of the
possibility of such damages. In any case, ABB AB's entire liability under any provision 
of this agreement shall be limited to the amount actually paid by you for the software.

ACKNOWLEDGEMENT

By opening the diskette package you acknowledge that you have read this agreement, understand it, and agree
to be bound by its terms and conditions. You also agree that it is the complete and exclusive statement of the
agreement between the parties and supersedes all proposals or prior agreement, oral or written, and any other
communications between the parties relating to the subject matter of the licence or limited warranty.

This Agreement is governed in all aspects by Swedish law. If any provisions of this Agreement are invalid or
unenforceable, all others will remain in effect.

IMPORTANT - READ CAREFULLY BEFORE OPENING

ABB Automation Technologies AB 

1. Grant of License

2. Copyright

3. Term

4. Other Restrictions

Limited Warranty

Customer Remedies

No Other Warranties

No Liability for
Consequential  Damages

This legal document is an agreement between You, the user, and ABB Automation Technologies AB, Västerås, SWEDEN. By 
opening the diskette package You indicate your acceptance of the terms and conditions of this agreement. If You do not agree 
to the terms of this agreement, promptly return the unopened diskette package and other items which are part of the product for a full
refund. Your product is a single user version unless you have a written agreement with ABB AB.

License Agreement

• ABB Automation Technologies AB warrants that the software will perform substantially in accordance with the 
accompanying Product Manual(s) for a period of 1 year from the date of delivery from ABB Automation Technologies 
AB, Västerås. ABB Automation Technologies AB does not warrant that the SOFTWARE is free from coding errors.

Automation Technologies 

Automation Technologies 
Automation Technologies 

Automation Technologies 

Automation Technologies 

Automation Technologies Automation 
Technologies 

Automation Technologies Automation 
Technologies 

Automation Technologies 

Automation Technologies 
Automation Technologies 

Automation Technologies 
SOFT-

Automation Technologies 
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Substation Automation
SE-721 59 Västerås
Sweden
Telephone: +46 (0) 21 34 20 00
Facsimile: +46 (0) 21 14 69 18
Internet: www.abb.com/substationautomation
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